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Result Windows Mac OS Toggle between Graph Editor and layer bar modes Shift+F3 Shift+F3 Select all keyframes for a property Click property name Click property name Select all visible keyframes and properties Ctrl+Alt+A Command+Option+A Deselect all keyframes, properties, and property groups Shift+F2 or Ctrl+Alt+Shift+A Shift+F2 or
Command+Option+Shift+A Move keyframe 1 frame later or earlier Alt+Right Arrow or Alt+Left Arrow Option+Right Arrow or Option+Left Arrow Move keyframe 10 frames later or earlier Alt+Shift+Right Arrow or Alt+Shift+Left Arrow Option+Shift+Right Arrow or Option+Shift+Left Arrow Set interpolation for selected keyframes (layer bar mode)
Ctrl+Alt+K Command+Option+K Set keyframe interpolation method to hold or Auto Bezier Ctrl+Alt+H Command+Option+H Set keyframe interpolation method to linear or Auto Bezier Ctrl-click in layer bar mode Command-click in layer bar mode Set keyframe interpolation method to linear or hold Ctrl+Alt-click in layer bar mode
Command+Option-click in layer bar mode Easy ease selected keyframes F9 F9 Easy ease selected keyframes in Shift+F9 Shift+F9 Easy ease selected keyframes out Ctrl+Shift+F9 Command+Shift+F9 Set velocity for selected keyframes Ctrl+Shift+K Command+ Shift+K Add or remove keyframe at current time. Result Windows Mac OS Group
selected shapes Ctrl+G Command+G Ungroup selected shapes Ctrl4+Shift+G Command+Shift+G Enter free-transform path editing mode Select Path property in Timeline panel and press Ctrl+T Select Path property in Timeline panel and press Command+T Increase star inner roundness Page Up when dragging to create shape Page Up when
dragging to create shape Decrease star inner roundness Page Down when dragging to create shape Page Down when dragging to create shape Increase number of points for star or polygon; increase roundness for rounded rectangle Up Arrow when dragging to create shape Up Arrow when dragging to create shape Decrease number of points for star
or polygon; decrease roundness for rounded rectangle Down Arrow when dragging to create shape Down Arrow when dragging to create shape Reposition shape during creation Hold spacebar when dragging to create shape Hold spacebar when dragging to create shape Set rounded rectangle roundness to 0 (sharp corners); decrease polygon and
star outer roundness Left Arrow when dragging to create shape Left Arrow when dragging to create shape Set rounded rectangle roundness to maximum; increase polygon and star outer roundness Right Arrow when dragging to create shape Right Arrow when dragging to create shape Constrain rectangles to squares; constrain ellipses to circles;
constrain polygons and stars to zero rotation Shift when dragging to create shape Shift when dragging to create shape Change outer radius of star Ctrl when dragging to create shape Command when dragging to create shape Set marker at current time (works during preview and audio-only preview) * (multiply) on numeric keypad * (multiply) on
numeric keypad or Control+8 on main keyboard Set marker at current time and open marker dialog box Alt+* (multiply) on numeric keypad Option+* (multiply) on numeric keypad or Control+Option+8 on main keyboard Set and number a composition marker (0-9) at the current time Shift+0-9 on main keyboard Shift+0-9 on main keyboard Go to a
composition marker (0-9) Display the duration between two layer markers or keyframes in the Info panel Alt-click the markers or keyframes Option-click the markers or keyframes Move feature region, search region, and attach point 1 pixel at current magnification Move feature region, search region, and attach point 10 pixels at current
magnification Move feature region and search region 1 pixel at current magnification Move feature region and search region 10 pixels at current magnification Saving, exporting, and rendering Increment and save project Add active composition or selected items to render queue Ctrl+Shift+/ (on main keyboard) Command+Shift+/ (on main keyboard)
Add current frame to render queue Duplicate render item with same output filename as original Add a composition to the Adobe Media Encoder encoding queue On Mac OS, some keyboard commands used to interact with the operating system conflict with keyboard commands for interacting with After Effects. 16-bpc and 32-bpc file formats While
After Effects can operate in 16 and 32 bits per channel, most video and animation file formats and codecs support only 8-bpc. Panel shortcuts You can assign shortcuts to commands in the Command list shortcut column. (decimal point) on numeric keypad* . PCX (PCX) Import only Windows only Portable Network Graphics (PNG) Import and Export 16-
bpc Radiance (HDR, RGBE, XYZE) Import and Export 32-bpc SGI (SGI, BW, RGB) Import and Export 16-bpc Softimage (PIC) Import only Targa (TGA, VDA, ICB, VST) Import and Export TIFF (TIF) Import and Export 8- and 16-bpc Video and animation file formats Format Import/Export support Format Details Panasonic Import only Camera
acquisition metadata displays in the Dynamic Media panel of the Metadata panel. Color coding Gray: In the keyboard layout, keys shaded gray do not have any shortcuts assigned to them. (period) Option+Shift+, (comma) or Option+Shift+. You can also render from After Effects with 10-bpc YUV compression. To use these shortcuts, press the letters
in quick succession. Video codecs that support 10-bpc are provided with hardware such as a capture card or software such as Adobe Premiere Pro. (Note: You can turn off this setting in the Preferences dialog box.) G G Temporarily activate Selection tool when a pen tool is selected Ctrl Command Temporarily activate Pen tool when the Selection tool
is selected and pointer is over a path (Add Vertex tool when pointer is over a segment; Convert Vertex tool when pointer is over a vertex) Ctrl+Alt Command+Option Activate and cycle through Brush, Clone Stamp, and Eraser tools Ctrl+B Command+B Activate and cycle through Puppet tools Ctrl+P Command+P Temporarily convert Selection tool to
Shape Duplication tool Alt (in shape layer) Option (in shape layer) Temporarily convert Selection tool to Direct Selection tool Ctrl (in shape layer) Command (in shape layer) Compositions and the work area Open Composition Settings dialog box for selected composition Set beginning or end of work area to current time Set work area to duration of
selected layers or, if no layers are selected, set work area to composition duration Open Composition Mini-Flowchart for active composition Activate the most recently active composition that is in the same composition hierarchy (network of nested compositions) as the currently active composition Trim Composition to work area New Composition
from selection Result Windows Mac OS Go to specific time Alt+Shift+] Option+Shift+] Go to beginning or end of work area Shift+Home or Shift+End Shift+Home or Shift+End Go to previous or next visible item in time ruler (keyframe, layer marker, work area beginning or end) (Note: Also goes to beginning, end, or base frame of Roto Brush span if
viewing Roto Brush in Layer panel.) J or K J or K Go to beginning of composition, layer, or footage item Home or Ctrl+Alt+Left Arrow Home or Command+Option+Left Arrow Go to end of composition, layer, or footage item End or Ctrl+Alt+Right Arrow End or Command+Option+Right Arrow Go forward 1 frame Page Down or Ctrl+Right Arrow Page
Down or Command+Right Arrow Go forward 10 frames Shift+Page Down or Ctrl+Shift+Right Arrow Shift+Page Down or Command+ Shift+Right Arrow Go backward 1 frame Page Up or Ctrl+Left Arrow Page Up or Command+Left Arrow Go backward 10 frames Shift+Page Up or Ctrl+Shift+Left Arrow Shift+Page Up or Command+ Shift+Left Arrow
Go to layer In point I I Go to layer Out point O O Go to previous In point or Out point Ctrl+Alt+Shift+Left Arrow Command+Option+Shift+Left Arrow Go to next In point or Out point Ctrl+Alt+Shift+Right Arrow Command+Option+Shift+Right Arrow Scroll to current time in Timeline panel D D Result Windows Mac OS Start or stop preview
Spacebar, 0 on numeric keypad, Shift+0 on numeric keypad Spacebar, 0 on numeric keypad, Shift+0 on numeric keypad Reset preview settings to replicate RAM Preview and Standard Preview behaviors Alt-click Reset in Preview panel Option-click Reset in Preview panel Preview only audio, from current time . Undo and Clear buttons in the lower
right corner are enabled. The editor is divided into three parts: Keyboard shortcut UI Keyboard layout: A representation of the hardware keyboard where you can view which keys have been assigned a shortcut, and which are available. (period) on main keyboard . Result Windows Mac OS Select all Ctrl+A Command+A Deselect all F2 or Ctrl+Shift+A
F2 or Command+Shift+A Rename selected layer, composition, folder, effect, group, or mask Enter on main keyboard Return Open selected layer, composition, or footage item Enter on numeric keypad Enter on numeric keypad Move selected layers, masks, effects, or render items down (back) or up (forward) in stacking order Ctrl+Alt+Down Arrow
or Ctrl+Alt+Up Arrow Command+Option+Down Arrow or Command+Option+Up Arrow Move selected layers, masks, effects, or render items to bottom (back) or top (front) of stacking order Ctrl+Alt+Shift+Down Arrow or Ctrl+Alt+Shift+Up Arrow Command+Option+Shift+Down Arrow or Command+Option+Shift+Up Arrow Extend selection to
next item in Project panel, Render Queue panel, or Effect Controls panel Shift+Down Arrow Shift+Down Arrow Extend selection to previous item in Project panel, Render Queue panel, or Effect Controls panel Shift+Up Arrow Shift+Up Arrow Duplicate selected layers, masks, effects, text selectors, animators, puppet meshes, shapes, render items,
output modules, or compositions Ctrl+D Command+D Quit Ctrl+Q Command+Q Undo Ctrl+Z Command+Z Redo Ctrl+Shift+Z Command+Shift+Z Purge All Memory Ctrl+Alt+/ (on numeric keypad) Command+Option+/ (on numeric keypad) Interrupt running a script Esc Esc Display filename corresponding to the frame at the current time in the Info
panel Ctrl+Alt+E Command+Option+E New folder in Project panel Open Project Settings dialog box Cycle through color bit depths for project Alt-click bit-depth button at bottom of Project panel Option-click bit-depth button at bottom of Project panel Open Project Settings dialog box Click bit-depth button at bottom of Project panel Click bit-depth
button at bottom of Project panel Open Preferences dialog box Command+Option+; (semicolon) Restore default preferences settings Hold down Ctrl+Alt+Shift while starting After Effects Hold down Command+Option+Shift while starting After Effects Panels, viewers, workspaces, and windows (Mac OS) Shortcuts involving function keys F9-F12 may
conflict with shortcuts used by the operating system. You can import 10-bpc uncompressed YUV AVI files created in Adobe Premiere Pro into 16-bpc RGB After Effects projects. (decimal point) on numeric keypad* Option+. You can also use the visual keyboard shortcut editor to customize the shortcuts and assign multiple shortcuts to a command.
Download Purple: In the keyboard layout, keys shaded purple are assigned application-wide shortcuts. (Press again to resize window so that contents fill the screen.) Ctrl+\ (backslash) Command+\ (backslash) Move application window or floating window to main monitor; resize window to fit screen. When you type a shortcut that is already in use with
another command, a warning message is displayed at the bottom of the editor. Green: In the keyboard layout keys shaded green are assigned panel-specific shortcuts. Saving custom keyboard shortcut sets You can modify the shortcuts and save them using the Save As button. Interactive content is not retained. (period) Activate a view in a multi-view
layout in the Composition panel without affecting layer selection Click with middle mouse button Click with middle mouse button You can activate some tools only under certain circumstances. (decimal point) on numeric keypad* or Control+. See Mac OS Help for instructions to reassign Dashboard & Expose shortcuts. You can import a JavaScript
syntax extension file (.jsx) into After Effects 15.1. The content of the JSX file can be the same as a JSON file imported into After Effects 15.0, you are required to change the file extension to .jsx. (period) on main keyboard Preview only audio, in work area Alt+. (period) Command+Option+Shift+, (comma) or Command+Option+Shift+. Audio format in
a WAV container file Advanced Audio Coding (AAC, M4A) Audio Interchange File Format (AIF, AIFF) MP3 (MP3, MPEG, MPG, MPA, MPE) Note: You can import files of any still image format as a sequence. Result Windows Mac OS Find in Timeline panel Ctrl+F Command+F Toggle expansion of selected layers to show all properties Ctrl+" (accent
grave) Command+" (accent grave) Toggle expansion of property group and all child property groups to show all properties Ctrl-click triangle to the left of the property group name Command-click triangle to the left of the property group name Show only Anchor Point property (for lights and cameras, Point Of Interest) A A Show only Audio Levels
property L. L. Show only Mask Feather property F F Show only Mask Path property M M Show only Mask Opacity property TT TT Show only Opacity property (for lights, Intensity) T T Show only Position property P P Show only Rotation and Orientation properties R R Show only Scale property S S Show only Time Remap property RR RR Show only
instances of missing effects FF FF Show only Effects property group E E Show only mask property groups MM MM Show only Material Options property group AA AA Show only expressions EE EE Show properties with keyframes U U Show only modified properties UU UU Show only paint strokes, Roto Brush strokes, and Puppet pins PP PP Show
only audio waveform LL LL Show only selected properties and groups SS SS Hide property or group Alt+Shift-click property or group name Option+Shift-click property or group name Add or remove property or group from set that is shown Shift+property or group shortcut Shift+property or group shortcut Add or remove keyframe at current time
Alt+Shift+property shortcut Option+property shortcut Showing properties in the Effect Controls panel Toggle expansion of selected effects to show all properties Toggle expansion of property group and all child property groups to show all properties Ctrl-click triangle to the left of the property group name Command-click triangle to the left of the
property group name Modifying layer properties Result Windows Mac OS Modify property value by default increments Drag property value Drag property value Modify property value by 10x default increments Shift-drag property value Shift-drag property value Modify property value by 1/10 default increments Ctrl-drag property value Command-drag
property value Open Auto-Orientation dialog box for selected layers Ctrl+Alt+0 Command+Alt+0O Open Opacity dialog box for selected layers Ctrl+Shift+O Command+Shift+0O Open Rotation dialog box for selected layers Ctrl+Shift+R Command+Shift+R Open Position dialog box for selected layers Ctrl+Shift+P Command+Shift+P Center-selected
layers in view (modifies Position property to place anchor points of selected layers in center of current view) Ctrl+ Home Command+Home Center anchor point in the visible content Ctrl+Alt+Home Command+Option+Home Move selected layers 1 pixel at current magnification (Position) Arrow key Arrow key Move selected layers 10 pixels at current
magnification (Position) Shift+arrow key Shift+arrow key Move selected layers 1 frame earlier or later Alt+Page Up or Alt+Page Down Option+Page Up or Option+Page Down Move selected layers 10 frames earlier or later Alt+Shift+Page Up or Alt+Shift+Page Down Option+Shift+Page Up or Option+Shift+Page Down Increase or decrease
Rotation (Z Rotation) of selected layers by 1° + (plus) or - (minus) on numeric keypad + (plus) or - (minus) on numeric keypad Increase or decrease Rotation (Z Rotation) of selected layers by 10° Shift++ (plus) or Shift+- (minus) on numeric keypad Shift++ (plus) or Shift+- (minus) on numeric keypad Increase or decrease Opacity (or Intensity for light
layers) of selected layers by 1% Ctrl+Alt++ (plus) or Ctrl+Alt+- (minus) on numeric keypad Control+Option++ (plus) or Control+Option+- (minus) on numeric keypad Increase or decrease Opacity (or Intensity for light layers) of selected layers by 10% Ctrl+Alt+Shift++ (plus) or Ctrl+Alt+Shift+- (minus) on numeric keypad Control+Option+Shift++
(plus) or Control+Option+Shift+- (minus) on numeric keypad Increase Scale of selected layers by 1% Ctrl++ (plus) or Alt++ (plus) on numeric keypad Command++ (plus) or Option++ (plus) on numeric keypad Decrease Scale of selected layers by 1% Ctrl+- (minus) or Alt+- (minus) on numeric keypad Command+- (minus) or Option+- (minus) on
numeric keypad Increase Scale of selected layers by 10% Ctrl+Shift++ (plus) or Alt+Shift++ (plus) on numeric keypad Command+Shift++ (plus) or Option+Shift++ (plus) on numeric keypad Decrease Scale of selected layers by 10% Ctrl+Shift+- (minus) or Alt+Shift+- (minus) on numeric keypad Command+Shift+- (minus) or Option+Shift+-
(minus) on numeric keypad Modify Rotation or Orientation in 45° increments Shift-drag with Rotation tool Shift-drag with Rotation tool Modify Scale, constrained to footage frame aspect ratio Shift-drag layer handle with Selection tool Shift-drag layer handle with Selection tool Reset Rotation to 0° Double-click Rotation tool Double-click Rotation tool
Reset Scale to 100% Double-click Selection tool Double-click Selection tool Scale and reposition selected layers to fit composition Ctrl+Alt+F Command+Option+F Scale and reposition selected layers to fit composition width, preserving image aspect ratio for each layer Ctrl+Alt+Shift+H Command+Option+Shift+H Scale and reposition selected
layers to fit composition height, preserving image aspect ratio for each layer Ctrl+Alt+Shift+G Command+Option+Shift+G (Mac OS) Shortcuts involving function keys F9-F12 may conflict with shortcuts used by the operating system. Learn how to create, manipulate, and optimize motion graphics for film, video, DVD, the web, and mobile devices.
This document lists the file formats which Adobe After Effects can import and export. The command in conflict is highlighted in blue, and clicking this automatically selects the command in the Command List. (period) Cycle to previous or next panel in active frame (for example, cycle through open Timeline panels) Alt+Shift+, (comma) or Alt+Shift+.
Maya camera data (MA) Import only OpenEXR (EXR) Import and Export 32-bpc 3D Channel effect plug-ins from fnord software are included with After Effects to provide access to multiple layers and channels of OpenEXR files. After Effects will convert the CMYK color values to RGB. Still image formats that support 16-bpc that After Effects can
render to include PSD, PNG, TIFF, IFF, and SGI. The online companion files include all the necessary assets for readers to complete the projects featured in each chapter as well as ebook updates when Adobe releases relevant new features for Creative Cloud customers. (period) Command+Shift+, (comma) or Command+Shift+. (period) Decrease or
increase font size of selected text by 10 units Ctrl+Alt+Shift+, (comma) or Ctrl+Alt+Shift+. Most file formats are rendered from After Effects by adding the composition to the render queue; see Render and export a movie using the render queue. If you open an existing project containing a JSON file that no longer works, use File > Replace Footage
to replace the JSON file with the JSX file. Command list: The list displays all the commands that can be assigned shortcuts. (period) on main keyboard Zoom-out in Composition, Layer, or Footage panel , (comma) , (comma) Zoom to 100% in Composition, Layer, or Footage panel / (on main keyboard) / (on main keyboard) Zoom to fit in Composition,
Layer, or Footage panel Shift+/ (on main keyboard) Shift+/ (on main keyboard) Zoom up to 100% to fit in Composition, Layer, or Footage panel Alt+/ (on main keyboard) Option+/ (on main keyboard) Set resolution to Full, Half, or Custom in Composition panel Ctrl+], Ctrl+Shift+], Ctrl+Alt+] Command+], Command+Shift+], Command+Option+]
Open View Options dialog box for active Composition panel Ctrl+Alt+U Command+Option+U Zoom in time = (equal sign) on main keyboard = (equal sign) on main keyboard Zoom out time - (hyphen) on main keyboard - (hyphen) on main keyboard Zoom in Timeline panel to single-frame units (Press again to zoom out to show entire composition
duration.) ; (semicolon) ; (semicolon) Zoom out in Timeline panel to show the entire composition duration (Press again to zoom back in to the duration specified by the Time Navigator.) Shift+; (semicolon) Shift+; (semicolon) Prevent images from being rendered for previews in viewer panels Caps Lock Caps Lock Show or hide safe zones ' (apostrophe)
' (apostrophe) Show or hide grid Ctrl+' (apostrophe) Command+' (apostrophe) Show or hide proportional grid Alt+' (apostrophe) Option+' (apostrophe) Show or hide rulers Ctrl+R Command+R Show or hide guides Ctrl+; (semicolon) Command+; (semicolon) Turn snapping to grid on or off Ctrl+Shift+' (apostrophe) Command+Shift+' (apostrophe)
Turn snapping to guides on or off Ctrl+Shift+; (semicolon) Command+Shift+; (semicolon) Lock or unlock guides Ctrl+Alt+Shift+; (semicolon) Command+Option+Shift+; (semicolon) Show or hide layer controls (masks, motion paths, light and camera wireframes, effect control points, and layer handles) Ctrl4+Shift+H Command+Shift+H Result
Windows Mac OS Import one file or image sequence Ctrl+I Command+I Import multiple files or image sequences Ctrl+Alt+I Command+Option+I Open movie in an After Effects Footage panel Double-click the footage item in the Project panel Double-click the footage item in the Project panel Add selected items to most recently activated composition
Ctrl+/ (on main keyboard) Command+/ (on main keyboard) Replace selected source footage for selected layers with footage item selected in Project panel Ctrl+Alt+/ (on main keyboard) Command+Option+/ (on main keyboard) Replace source for a selected layer Alt-drag footage item from Project panel onto selected layer Option-drag footage item
from Project panel onto selected layer Delete a footage item without a warning Ctrl+Backspace Command+Delete Open Interpret Footage dialog box for selected footage item Ctrl+Alt+G Command+Option+G Remember footage interpretation Ctrl+Alt+C Command+Option+C Edit selected footage item in application with which it’s associated (Edit
Original) Ctrl+E Command+E Replace selected footage item Ctrl+H Command+H Reload selected footage items Ctrl+Alt+L Command+Option+L Set proxy for selected footage item Ctrl+Alt+P Command+Option+P Effects and animation presets Delete all effects from selected layers Apply most recently applied effect to selected layers Apply most
recently applied animation preset to selected layers Some operations do not affect shy layers. (See Using channels in OpenEXR files in After Effects help. Click the link below to download a PDF of about 50 of the more commonly used and pouplar keyboard shortcuts. Alt+Shift+property shortcut Option+property shortcut Result Windows Mac OS New
text layer Ctrl+Alt+Shift+T Command+Option+Shift+T Align selected horizontal text left, center, or right Ctrl+Shift+L, Ctrl+Shift+C, or Ctrl+Shift+R Command+Shift+L, Command+Shift+C, or Command+Shift+R Align selected vertical text top, center, or bottom Ctrl+Shift+L, Ctrl+Shift+C, or Ctrl+Shift+R Command+Shift+L,
Command+Shift+C, or Command+Shift+R Extend or reduce selection by one character to right or left in horizontal text Shift+Right Arrow or Shift+Left Arrow Shift+Right Arrow or Shift+Left Arrow Extend or reduce selection by one word to right or left in horizontal text Ctrl+Shift+Right Arrow or Ctrl+Shift+Left Arrow Command+Shift+Right
Arrow or Command+Shift+Left Arrow Extend or reduce selection by one line up or down in horizontal text Shift+Up Arrow or Shift+Down Arrow Shift+Up Arrow or Shift+Down Arrow Extend or reduce selection by one line to right or left in vertical text Shift+Right Arrow or Shift+Left Arrow Shift+Right Arrow or Shift+Left Arrow Extend or reduce
selection one word up or down in vertical text Ctrl+Shift+Up Arrow or Ctrl+Shift+Down Arrow Command+ Shift+Up Arrow or Command+ Shift+Down Arrow Extend or reduce selection by one character up or down in vertical text Shift+Up Arrow or Shift+Down Arrow Shift+Up Arrow or Shift+Down Arrow Select text from insertion point to
beginning or end of line Shift+Home or Shift+End Shift+Home or Shift+End Move insertion point to beginning or end of line Home or End Home or End Select all text on a layer Double-click text layer Double-click text layer Select text from insertion point to beginning or end of text frame Ctrl+Shift+ Home or Ctrl+Shift+End Command+ Shift+ Home
or Command+ Shift+End To mouse-click point, select text from insertion point Shift-click Shift-click In horizontal text, move insertion point one character left or right; one line up or down; one word left or right; or one paragraph up or down Left Arrow or Right Arrow; Up Arrow or Down Arrow; Ctrl+Left Arrow or Ctrl4+Right Arrow; or Ctrl+Up Arrow
or Ctrl+Down Arrow Left Arrow or Right Arrow; Up Arrow or Down Arrow; Command+Left Arrow or Command+Right Arrow; or Command+Up Arrow or Command+Down Arrow In vertical text, move insertion point one character up or down; one left or right; one word up or down; or one paragraph left or right Up Arrow or Down Arrow; Left Arrow
or Right Arrow; Ctrl+Up Arrow or Ctrl+Down Arrow; or Ctrl+Left Arrow or Ctrl+Right Arrow Up Arrow or Down Arrow; Left Arrow or Right Arrow; Command+Up Arrow or Command+Down Arrow; or Command+Left Arrow or Command+Right Arrow Select word, line, paragraph, or entire text frame Double-click, triple-click, quadruple-click, or
quintuple-click with Type tool Double-click, triple-click, quadruple-click, or quintuple-click with Type tool Turn All Caps on or off for selected text Ctrl+Shift+K Command+Shift+K Turn Small Caps on or off for selected text Ctrl+Alt+Shift+K Command+Option+Shift+K Turn Superscript on or off for selected text Ctrl+Shift+= (equal sign)
Command+Shift+= (equal sign) Turn Subscript on or off for selected text Ctrl+Alt+Shift+= (equal sign) Command+Option+Shift+= (equal sign) Set horizontal scale to 100% for selected text Ctrl+Shift+X Command+Shift+X Set vertical scale to 100% for selected text Ctrl+Alt+Shift+X Command+Option+Shift+X Auto leading for selected text
Ctrl+Alt+Shift+ A Command+Option+Shift+A Reset tracking to 0 for selected text Ctrl+Shift+Q Command+Shift+Control+Q Justify paragraph; left align last line Ctrl+Shift+] Command+Shift+] Justify paragraph; right align last line Ctrl+Alt+Shift+] Command+Option+Shift+] Justify paragraph; force last line Ctrl+Shift+F Command+Shift+F
Decrease or increase font size of selected text by 2 units Ctrl+Shift+, (comma) or Ctrl+Shift+. eBook (Watermarked) ISBN-10: 0-13-487251-7 ISBN-13: 978-0-13-487251-3 Creative professionals seeking the fastest, easiest, most comprehensive way to learn Adobe After Effects CC (2018 release) choose Adobe After Effects CC Classroom in a Book
(2018 release) from Adobe Press. Format Import/Export support Format Details Adobe Illustrator (Al, EPS, PS) Import only Continuously rasterized Adobe PDF (PDF) Import only First page only, continuously rasterized. The Command list displays the Application command assigned to it. The Command list displays the entire set of commands
available. (period) Shift+, (comma) or Shift+. For a list of software developers that make plug-ins for After Effects, see Plug-ins. The keyboard layout displays application-wide shortcuts by default. These shortcuts work irrespective of which panel is selected. Ctrl+Shift+W Command+Shift+W Split the frame containing the active viewer and create a
viewer with opposite locked/unlocked state Ctrl+Alt+Shift+N Command+Option+Shift+N Maximize or restore panel under pointer * (accent grave) * (accent grave) Resize application window or floating window to fit screen. RED Import only Sony X-OCN Import only Canon EOS C200 Cinema RAW Light (.crm) Import only RED Image Processing
Import only Sony VENICE X-OCN 4K 4:3 Anamorphic and 6K 3:2 (.mxf) Import only MXF/ARRIRAW Import only ARRIRAW codec in an MXF container file H.265 (HEVC) Import only HEVC (also known as H.265) codec footage in a QuickTime (.MOV) container 3GPP (3GP, 3G2, AMC) Import only Adobe Flash Player (SWF) Import only Note: SWF
files are imported with an alpha channel. Gain hands-on experience animating text and images, customizing a wide range of effects, tracking and syncing content, rotoscoping, and correcting color. (decimal point) on numeric keypad* or Control+Option+. When a Panel shortcut has the same assigned shortcut as an Application shortcut, the
application-wide shortcut does not function when that panel is active. When After Effects detects a non-supported keyboard, the default view is to display the U.S. English keyboard. Result Windows Mac OS Turn display color management on or off for active view Shift+/ (on numeric keypad) Shift+/ (on numeric keypad) Show red, green, blue, or
alpha channel as grayscale Alt+1, Alt+2, Alt+3, Alt+4 Option+1, Option+2, Option+3, Option+4 Show colorized red, green, or blue channel Alt+Shift+1, Alt+Shift+2, Alt+Shift+3 Option+Shift+1, Option+Shift+2, Option+Shift+3 Toggle showing straight RGB color Alt+Shift+4 Option+Shift+4 Show alpha boundary (outline between transparent
and opaque regions) in Layer panel Alt+5 Option+5 Show alpha overlay (colored overlay on transparent regions) in Layer panel Alt+6 Option+6 Show Refine Edge X-ray Alt+X Option+X Center composition in the panel Double-click Hand tool Double-click Hand tool Zoom-in in Composition, Layer, or Footage panel . (period) Increase or decrease
leading by 2 units Alt+Down Arrow or Alt+Up Arrow Option+Down Arrow or Option+Up Arrow Increase or decrease leading by 10 units Ctrl+Alt+Down Arrow or Ctrl+Alt+Up Arrow Command+Option+Down Arrow or Command+Option+Up Arrow Decrease or increase baseline shift by 2 units Alt+Shift+Down Arrow or Alt+Shift+Up Arrow
Option+Shift+Down Arrow or Option+Shift+Up Arrow Decrease or increase baseline shift by 10 units Ctrl+Alt+Shift+Down Arrow or Ctrl+Alt+Shift+Up Arrow Command+Option+Shift+Down Arrow or Command+Option+Shift+Up Arrow Decrease or increase kerning or tracking 20 units (20/1000 ems) Alt+Left Arrow or Alt+Right Arrow
Option+Left Arrow or Option+Right Arrow Decrease or increase kerning or tracking 100 units (100/1000 ems) Ctrl+Alt+Left Arrow or Ctrl+Alt+Right Arrow Command+Option+Left Arrow or Command+Option+Right Arrow Toggle paragraph composer Ctrl+Alt+Shift+T Command+Option+Shift+T Result Windows Mac OS New mask Ctrl+Shift+N
Command+Shift+N Select all points in a mask Alt-click mask Option-click mask Select next or previous mask Alt+" (accent grave) or Alt+Shift+" (accent grave) Option+" (accent grave) or Option+Shift+" (accent grave) Enter free-transform mask editing mode Double-click mask with Selection tool or select mask in Timeline panel and press Ctrl+T
Double-click mask with Selection tool or select mask in Timeline panel and press Command+T Exit free-transform mask editing mode Esc Esc Scale around center point in Free Transform mode Ctrl-drag Command-drag Move selected path points 1 pixel at current magnification Arrow key Arrow key Move selected path points 10 pixels at current
magnification Shift+arrow key Shift+arrow key Toggle between smooth and corner points Ctrl+Alt-click vertex Command+Option-click vertex Redraw Bezier handles Ctrl+Alt-drag vertex Command+Option-drag vertex Invert selected mask Ctrl+Shift+I Command+Shift+I Open Mask Feather dialog box for selected mask Ctrl+Shift+F
Command+Shift+F Open Mask Shape dialog box for selected mask Ctrl+Shift+M Command+Shift+M Subtract mode S S Darken mode D D Difference mode F F Add mode A S Intersect mode I I None N N Result Windows Mac OS Swap paint background color and foreground colors X X Set paint foreground color to black and background color to
white D D Set foreground color to the color currently under any paint tool pointer Alt-click Option-click Set foreground color to the average color of a 4-pixel x 4-pixel area under any paint tool pointer Ctrl+Alt-click Command+Option-click Set brush size for a paint tool Ctrl-drag Command-drag Set brush hardness for a paint tool Ctrl-drag, then
release Ctrl while dragging Command-drag, then release Command while dragging Join current paint stroke to the previous stroke Hold Shift while beginning stroke Hold Shift while beginning stroke Set starting sample point to point currently under Clone Stamp tool pointer Alt-click Option-click Momentarily activate Eraser tool with Last Stroke
Only option Ctrl+Shift Command+Shift Show and move overlay (change Offset value of aligned Clone Stamp tool or change Source Position value of unaligned Clone Stamp tool) Alt+Shift-drag with Clone Stamp tool Option+ Shift-drag with Clone Stamp tool Activate a specific Clone Stamp tool preset 3, 4, 5, 6, or 7 on the main keyboard 3, 4, 5, 6, or 7
on the main keyboard Duplicate a Clone Stamp tool preset in Paint panel Alt-click the button for the preset Option-click the button for the preset Set opacity for a paint tool Digit on numeric keypad (for example, 9=90%, 1=10%)* Digit on numeric keypad (for example, 9=90%, 1=10%)* Set opacity for a paint tool to 100% . Hover over a key to view a
tool tip containing the full name of the command, and information whether it is an Application or Panel shortcut. Result Windows Mac OS New solid layer Ctrl+Y Command+Y New null layer Ctrl+Alt+Shift+Y Command+Option+Shift+Y New adjustment layer Ctrl+Alt+Y Command+Option+Y Select layer (1-999) by its number (enter digits rapidly for
two-digit and three-digit numbers) 0-9 on numeric keypad* 0-9 on numeric keypad* Toggle selection of layer (1-999) by its number (enter digits rapidly for two-digit and three-digit numbers) Shift+0-9 on numeric keypad* Shift+0-9 on numeric keypad* Select next layer in stacking order Ctrl+Down Arrow Command+Down Arrow Select previous layer
in stacking order Ctrl+Up Arrow Command+Up Arrow Extend selection to next layer in stacking order Ctrl+Shift+Down Arrow Command+ Shift+Down Arrow Extend selection to previous layer in stacking order Ctrl+Shift+Up Arrow Command+Shift+Up Arrow Deselect all layers Ctrl+Shift+A Command+Shift+A Scroll topmost selected layer to top
of Timeline panel X X Show or hide Parent column Shift+F4 Shift+F4 Show or hide Layer Switches and Modes columns F4 F4 Setting the sampling method for selected layers (Best/Bilinear) Alt+B Option+B Setting the sampling method for selected layers (Best/Bicubic) Alt+Shift+B Option+Shift+B Turn off all other solo switches Alt-click solo switch
Option-click solo switch Turn Video (eyeball) switch on or off for selected layers Ctrl+Alt+Shift+V Command+Option+Shift+V Turn off Video switch for all video layers other than selected layers Ctrl+Shift+V Command+Shift+V Open settings dialog box for selected solid, light, camera, null, or adjustment layer Ctrl+Shift+Y Command+Shift+Y Paste
layers at current time Ctrl+Alt+V Command+Option+V Split selected layers. Work with Visual Keyboard Shortcut Editor To open the editor, select Edit > Keyboard Shortcuts (Ctrl+Alt+'). To effectively color manage CMYK files you should convert them to RGB before you import them into After Effects. When you view a set of Panel shortcuts, only
the commands specific to that panel are displayed. A Panel shortcut is already in use by another command in the same panel. A Panel shortcut overrides an Application shortcut when that panel has focus. Typical cross-application workflows for higher bit-depth color involve rendering to a still image sequence rather than a video or animation file. You
can add support for additional file formats to After Effects by installing a third-party plug-in. (If no layers are selected, split all layers.) Ctrl+Shift+D Command+Shift+D Precompose selected layers Ctrl+Shift+C Command+Shift+C Open Effect Controls panel for selected layers Ctrl+Shift+T Command+Shift+T Open layer in Layer panel (opens
source composition for precomposition layer in Composition panel) Double-click a layer Double-click a layer Open source of a layer in Footage panel (opens precomposition layer in Layer panel) Alt-double-click a layer Option-double-click a layer Reverse selected layers in time Ctrl+Alt+R Command+Option+R Enable time remapping for selected
layers Ctrl+Alt+T Command+Option+T Move selected layers so that their In point or Out point is at the current time [ (left bracket) or ] (right bracket) [ (left bracket) or ] (right bracket) Trim In point or Out point of selected layers to current time Alt+[ (left bracket) or Alt+] (right bracket) Option+[ (left bracket) or Option+] (right bracket) Add or
remove expression for a property Alt-click stopwatch Option-click stopwatch Add an effect (or multiple selected effects) to selected layers Double-click effect selection in Effects & Presets panel Double-click effect selection in Effects & Presets panel Set In point or Out point by time-stretching Ctrl+Shift+, (comma) or Ctrl+Alt+, (comma)

Command+ Shift+, (comma) or Command+Option+, (comma) Move selected layers so that their In point is at beginning of composition Alt+Home Option+Home Move selected layers so that their Out point is at end of composition Alt+End Option+End Lock selected layers Ctrl+L Command+L Unlock all layers Ctrl+Shift+L. Command+Shift+L Set
Quality to Best, Draft, or Wireframe for selected layers Ctrl+U, Ctrl+Shift+U, or Ctrl+Alt+Shift+U Command+U, Command+Shift+U, Command+Option+Shift+U Cycle forward or backward through blending modes for selected layers Shift+- (hyphen) or Shift+= (equal sign) on the main keyboard Shift+- (hyphen) or Shift+= (equal sign) on the main
keyboard Find in Timeline panel Ctrl+F Command+F Some shortcuts are marked with an asterisk (*) to remind you to make sure that Num Lock is on when you use the numeric keypad. To activate a tool and keep it active, press the key and immediately release it. Some formats are only available through the File > Export menu; see Render and
export a movie using QuickTime components. For example, you can activate a camera tool only when the active composition contains a camera layer. After Effects can render HDR color in imported QuickTime files using Apple ProRes codecs that are tagged for Rec. (decimal) on numeric keypad* Shift+. Result Windows Mac OS Cycle through tools
Alt-click tool button in Tools panel Option-click tool button in Tools panel Activate Selection tool V V Activate Hand tool H H Temporarily activate Hand tool Hold down spacebar or the middle mouse button Hold down spacebar or the middle mouse button Activate Zoom In tool Z Z Activate Zoom Out tool Alt (when Zoom In tool is active) Option (when
Zoom In tool is active) Activate Rotation tool W W Activate Roto Brush tool Alt+W Option+W Activate Refine Edge tool Alt+W Option+W Activate and cycle through Camera tools (Unified Camera, Orbit Camera, Track XY Camera, and Track Z Camera) C C Activate Pan Behind tool Y Y Activate and cycle through mask and shape tools (Rectangle,
Rounded Rectangle, Ellipse, Polygon, Star) Q Q Activate and cycle through Type tools (Horizontal and Vertical) Ctrl+T Command+T Activate and cycle between the Pen and Mask Feather tools. MPEG-4 (MP4, M4V) Import only Open Media Framework (OMF) Import and Export Raw media [or essence] only; Windows only QuickTime (MOV) Import
and Export Video for Windows (AVI) Import and Export Export is on Windows only. Showing properties and groups in the Timeline panel This table contains double-letter shortcuts (for example, LL). Windows Media (WMV, WMA) Import only Windows only XDCAM HD and XDCAM EX (MXF, MP4) Import only After Effects 15.1 and later use a
different JSON parser that is strict and will not allow a JSON file with illegal syntax to be imported. You can search for commands in the Command List, which is filtered by the search criteria. Create Motion Graphics templates in After Effects so colleagues can make specific edits in Premiere Pro without accidentally changing other critical settings. In
some cases, you can import these files into After Effects after changing the filename extension to one of the recognized filename extensions. Minimum supported operating systems for HEIF file import: Note: HEIF Image and HEVC Image Extensions are not included with Windows 10 and must be installed separately. The 15 project-based lessons in
this book show users step-by-step the key techniques for working in After Effects. Result Windows Mac OS Open or close Project panel Ctrl+0 Command+0 Open or close Render Queue panel Ctrl+Alt+0 Command+Option+0 Open or close Tools panel Ctrl+1 Command+1 Open or close Info panel Ctrl+2 Command+2 Open or close Preview panel
Ctrl+3 Command+3 Open or close Audio panel Ctrl+4 Command+4 Open or close Effects & Presets panel Ctrl+5 Command+5 Open or close Character panel Ctrl+6 Command+6 Open or close Paragraph panel Ctrl+7 Command+7 Open or close Paint panel Ctrl+8 Command+8 Open or close Brushes panel Ctrl+9 Command+9 Open or close Effect
Controls panel for selected layer F3 or Ctrl+Shift+T F3 or Command+Shift+T Open Flowchart panel for project flowchart Ctrl+F11 Command+F11 Switch to workspace Shift+F10, Shift+F11, or Shift+F12 Shift+F10, Shift+F11, or Shift+F12 Close active viewer or panel (closes content first) Ctrl+W Command+W Close active panel or all viewers of



type of active viewer (closes content first). The Key modifier list inspects and it displays a list of all the commands assigned to the key and each of the possible modifier combinations. Key modifier list: The list displays all the modifier combinations and assigned shortcuts associated with the key you select on the keyboard layout. To momentarily
activate a tool with a single-letter keyboard shortcut, hold down the key; release the key to return to the previously active tool. (Press again to resize window so that contents fill the screen.) Ctrl4+Alt+\ (backslash) Command+Option+\ (backslash) Toggle activation between Composition panel and Timeline panel for current composition \ (backslash) \
(backslash) Cycle to previous or next item in active viewer (for example, cycle through open compositions) Shift+, (comma) or Shift+. (decimal) on numeric keypad* Move earlier or later by number of frames specified for stroke Duration Ctrl+Page Up or Ctrl+Page Down (or 1 or 2 on the main keyboard) Command+Page Up or Command+Page Down
(or 1 or 2 on the main keyboard) Some shortcuts are marked with an asterisk (*) to remind you to make sure that Num Lock is on when you use the numeric keypad. For more information, see Interpret a footage item by assigning an input color profile. If you receive an error message or the video does not display correctly, you may need to install the
codec used by the file. After Effects User Guide Beta releases Getting started Workspaces Projects and compositions Importing footage Text and Graphics Drawing, Painting, and Paths Layers, Markers, and Camera Animation, Keyframes, Motion Tracking, and Keying Transparency and Compositing Adjusting color Effects and Animation Presets
Expressions and Automation Immersive video, VR, and 3D Views and Previews Previewing Video preview with Mercury Transmit Modifying and using views Rendering and Exporting Working with other applications Collaboration: Frame.io, and Team Projects Memory, storage, performance Here you'll find a comprehensive list of media file formats
supported in After Effects. These shortcuts only work when the specific panel is active. All buyers of the book get full access to the Web Edition: a Web-based version of the complete ebook enhanced with video and multiple-choice quizzes. GETTING STARTED 1 GETTING TO KNOW THE WORKFLOW 2 CREATING A BASIC ANIMATION USING
EFFECTS AND PRESETS 3 ANIMATING TEXT 4 WORKING WITH SHAPE LAYERS 5 ANIMATING A MULTIMEDIA PRESENTATION 6 ANIMATING LAYERS 7 WORKING WITH MASKS 8 DISTORTING OBJECTS WITH THE PUPPET TOOLS 9 USING THE ROTO BRUSH TOOL 10 PERFORMING COLOR CORRECTION 11 CREATING MOTION
GRAPHICS TEMPLATES 12 USING 3D FEATURES 13 WORKING WITH THE 3D CAMERA TRACKER 14 ADVANCED EDITING TECHNIQUES 15 RENDERING AND OUTPUTTING APPENDIX: GENERAL KEYBOARD SHORTCUTS APPENDIX: CUSTOMIZING KEYBOARD SHORTCUTS Submit Errata After Effects User Guide Beta releases
Getting started Workspaces Projects and compositions Importing footage Text and Graphics Drawing, Painting, and Paths Layers, Markers, and Camera Animation, Keyframes, Motion Tracking, and Keying Transparency and Compositing Adjusting color Effects and Animation Presets Expressions and Automation Immersive video, VR, and 3D Views
and Previews Previewing Video preview with Mercury Transmit Modifying and using views Rendering and Exporting Working with other applications Collaboration: Frame.io, and Team Projects Memory, storage, performance Use this handy list to reference keyboard shortcuts for After Effects and even print a PDF of the keyboard shortcuts. Export
functionality of SWF files is supported by versions earlier than After Effects CC 2014. You can switch to panel-specific view from the Command drop-down list. After Effects does not allow you to reassign the following keys: AAAEEEFFFLLLM, MMPPPRRRSSST TT U UU Long commands assigned to keys are abbreviated. By default, the After
Effects Default preset is displayed. Learn to create 3D content with both After Effects and Maxon Cinema 4D Lite (included with the software). Adobe Photoshop (PSD) Import and Export 8-, 16-, and 32-bpc Bitmap (BMP, RLE, DIB) Import only Camera raw (TIF, CRW, NEF, RAF, ORF, MRW, DCR, MOS, RAW, PEF, SRF, DNG, X3F, CR2, ERF) Import
only Cineon (CIN, DPX) Import and Export Converts to project's color bit depth: 8-, 16-, or 32-bpc CompuServe GIF (GIF) Import only Discreet RLA/RPF (RLA, RPF) Import only 16-bpc, imports camera data Electricimage IMAGE (IMG, EI) Import only Encapsulated PostScript (EPS) Import only IFF (IFF, TDI) Import and Export JPEG (JPG, JPE)
Import and Export HEIF Import only On supported operating systems, After Effects can import HEIF files (High Efficiency Image Format; .HEIF and .HEIC), such as those created by the camera apps on Apple iOS 11 or later. Formats that support 32-bpc include PSD, EXR, HDR, and TIFF. Because of variations in implementation in these container
formats, compatibility is not guaranteed. You can use the keyboard user interface to view the keys that have been assigned shortcuts, available keys for assignment, and modify assigned shortcuts. You can drag keys in the keyboard layout onto a command in the Command List to assign them to the command. For example, if a Timeline panel is active,
this command closes all Timeline panels. Select Use System Shortcut Keys in the General preferences to override the After Effects keyboard command sometimes in which there’s a conflict with the Mac OS keyboard command. Result Windows Mac OS Switch to 3D view 1 (defaults to Front) F10 F10 Switch to 3D view 2 (defaults to Custom View 1)
F11 F11 Switch to 3D view 3 (defaults to Active Camera) F12 F12 Return to previous view Esc Esc New light Ctrl+Alt+Shift+L Command+Option+Shift+L Switch to Orbit camera control 1 1 Switch to Pan camera control 2 2 Switch to Dolly camera control 3 3 New camera Ctrl+Alt+Shift+C Command+Option+Shift+C Switch to Universal gizmo V'V
Switch to Position gizmo 4 4 Switch to Scale gizmo 5 5 Switch to Rotation gizmo 6 6 Move the camera and its point of interest to look at selected 3D layers Ctrl+Alt+Shift+\ Command+Option+Shift+\ With a camera tool selected, move the camera and its point of interest to look at selected 3D layers F F With a camera tool selected, move the camera
and its point of interest to look at all 3D layers Ctrl+Shift+F Command+Shift+F Turn Casts Shadows property on or off for selected 3D layers Alt+Shift+C Option+Shift+C Keyframes and the Graph Editor (Mac OS) Shortcuts involving function keys F9-F12 may conflict with shortcuts used by the operating system. Color management on CMYK files is
therefore limited. When you select a key in the keyboard layout for application-wide commands, the key is outlined with a blue focus indicator. AVCHD (M2TS) Import only DV Import and Export In MOV or AVI container, or as container-less DV stream; requires QuickTime on Windows H.264 (M4V) Import only Media eXchange Format (MXF)
Import only MPEG-1 (MPG, MPE, MPA, MPV, MOD) Import only MPEG-2 (MPG, M2P, M2V, M2P, M2A, M2T) Import only Some MPEG data formats are stored in container formats with filename extensions that are not recognized by After Effects; examples include .vob and .mod. Conflicts and resolutions A warning indicating a shortcut conflict
appears when: An Application shortcut already in use by another Application shortcut. For more information about the codec in use, contact the manufacturer of the software or hardware used to create the file. (period) on main keyboard Manually preview (scrub) video Drag or Alt-drag current-time indicator, depending on Live Update setting Drag or
Option-drag current-time indicator, depending on Live Update setting Manually preview (scrub) audio Ctrl-drag current-time indicator Command-drag current-time indicator Preview number of frames specified by Alternate Preview preference (defaults to 5) Alt+0 on numeric keypad* Option+0 on numeric keypad* or Control+Option+0 (zero) on
main keyboard Toggle Mercury Transmit video preview / (on numeric keypad) / (on numeric keypad), Control+/ on main keyboard Take snapshot Shift+F5, Shift+F6, Shift+F7, or Shift+F8 Shift+F5, Shift+F6, Shift+F7, or Shift+F8 Display snapshot in active viewer F5, F6, F7, or F8 F5, F6, F7, or F8 Purge snapshot Ctrl+Shift+F5, Ctrl+Shift+F6,
Ctrl+Shift+F7, or Ctrl+Shift+F8 Command+Shift+F5, Command+Shift+F6, Command+Shift+F7, or Command+Shift+F8 Fast Previews > Off Ctrl+Alt+1 Command+Option+1 Fast Previews > Adaptive Resolution Ctrl+Alt+2 Command+Option+2 Fast Previews > Draft Ctrl+Alt+3 Command+Option+3 Fast Previews > Fast Draft Ctrl+Alt+4
Command+Option+4 Fast Previews > Wireframe Ctrl+Alt+5 Command+Option+5 Some shortcuts are marked with an asterisk (*) to remind you to make sure that Num Lock is on when you use the numeric keypad. For more information, see QuickTime 7 support has ended. 2020 color, including PQ or HLG profiles, such as those produced by Atomos
monitor-recorders. (decimal) on numeric keypad* . Select the command and type the shortcut in the text field. Visual Keyboard Shortcut Editor You can work visually when you lay out your keyboard shortcuts with the visual keyboard shortcut editor. The After Effects 15.1 release no longer supports legacy 32-bit QuickTime operations on macOS and
Windows. For property shortcuts, see Showing properties and groups in the Timeline panel (keyboard shortcuts). See Preparing and importing still images in After Effects help. The keyboard layout only displays keys shaded green. Import uses Cineware effect Maya Scene camera data (MA) After Effects can import Adobe Photoshop (.PSD), Adobe
Ilustrator (.AlI), and Encapsulated PostScript (.EPS) files that use the CMYK color space. Adobe Flash Video (FLV, F4V) Import only Animated GIF (GIF) Import Apple ProRes codec Export only On Windows. You can also assign shortcuts by clicking in the shortcut column and tapping keys on their keyboard to create the shortcut (including adding
modifiers). You can also assign shortcuts by dragging a command from the Command list onto a key in the keyboard layout or to the Key modifier list. (decimal) on numeric keypad* Set flow for a paint tool Shift+ a digit on numeric keypad (for example, 9=90%, 1=10%)* Shift+ a digit on numeric keypad (for example, 9=90%, 1=10%)* Set flow for a
paint tool to 100% Shift+. Note: After Effects cannot assign an input color profile to files that use non-RGB color spaces, such as CMYK.
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